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Introduction 

How to Use This Document 
 
This document is for administrators responsible for installing and configuring XenDesktop with 
Microsoft’s Hyper-V product.  Step-by-step procedures for creating an evaluation deployment to 
deliver virtual desktops are provided. 

 

To achieve the objective of getting your XenDesktop evaluation environment up and running in 
the shortest possible time, the installation procedure detailed here helps you to set up a basic 
deployment. To find out more about the components included in XenDesktop and for 
information about advanced configuration, see the Citrix XenDesktop Administrator’s Guide and 
the documentation for the individual components. 

 

This document assumes experience of basic Windows server administration and knowledge of 
Active Directory. For more information about Active Directory, visit 
https://www.microsoft.com/windowsserver2008/en/us/active-directory.aspx. 

 

Finding More Information 
This document is part of the Citrix XenDesktop documentation set. You can access more 
documentation for XenDesktop and its components from the XenDesktop product information 
page on the Citrix Web site http://support.citrix.com/product/xd/v3.0/#tab-doc. Information 
available for each component includes administrator’s guides, release notes, readmes, 
technical articles, and white papers. 

 

The Citrix Knowledge Center Web site, http://support.citrix.com/, contains links to all product 
documentation, organized by component. Select the component you want to access and click 
the Documentation tab on the product information page. 
To provide feedback about the documentation, click the Article Feedback link located on the 

right side of the product documentation page. 

 

Getting Support and Training 

For additional support with XenDesktop, visit the XenDesktop Support forum at 
http://forums.citrix.com/forum.jspa?forumID=187. This forum contains up-to-date information for 
Citrix customers and partners. Note that on Citrix forums, you can set up a forum watch to 
receive email updates about the latest postings. 

 

The Citrix Knowledge Center (http://support.citrix.com) offers a variety of technical support 
services, tools, and developer resources. 

Information about Citrix training is available at http://www.citrixtraining.com/. 
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Overview 
 

Citrix XenDesktop is a desktop virtualization system that centralizes and delivers virtual 
desktops as a service to users, significantly reducing cost of ownership and improving data 
security by centralizing desktop life-cycle management in the data center. The open architecture 
of XenDesktop offers a choice of virtualization platforms and endpoint devices. Unlike other 
desktop virtualization alternatives, XenDesktop simplifies desktop management by using a 
single image to deliver virtual desktops to users and enables administrators to manage service 
levels with built-in desktop performance monitoring. 

Citrix XenDesktop delivers Microsoft Windows Vista or Windows XP virtual desktops to users 

anywhere on a wide variety of endpoint devices. Virtual desktops are dynamically assembled on 

demand, providing users with pristine, yet personalized, desktops each time they log on. This 

ensures that performance never degrades, while the high speed delivery protocol provides 

unparalleled responsiveness over any connection, including high latency wide area networks. 

 

 
 

 
The figure shows the XenDesktop virtual desktop delivery model. 
 

XenDesktop deployments comprise a number of core components that work together to provide 
the virtual desktops delivered to users. This document provides step-by-step instructions on 
how to set up a simplified XenDesktop deployment that includes all these core components. 
You can use this evaluation environment to experience virtual desktops, to try out the features 
of XenDesktop, and to gain a greater understanding of the core components and how they 
interact before moving to a full scale production deployment. 
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Product Features and Benefits 

Our features have been grouped in 8 major categories in order to clearly communicate product 

value proposition as well as competitive differentiation.  

 
1. Best desktop TCO. Centralizing and simplifying desktop lifecycle management, 

dramatically reduces storage and endpoint costs, and provides the lowest TCO for 

desktops. 

 

2. Single image desktop management. Maintaining a single master desktop image in 

the datacenter provides users with an up-to-date, pristine desktop at each logon, 

drastically reduces patch and upgrade maintenance efforts, and cuts storage costs by 

up to 90 percent. 

 

3. Real-time desktop assembly. Users are instantly provisioned with a pristine desktop 

that incorporates the user’s personal settings and applications, regardless of the 

access device. 

 

4. High definition user experience. The ability to access a personalized, well-managed 

and high performance desktop from any device or location makes virtual desktops 

better than a PC for end users. 

 

5. Built-in virtual applications. Virtual applications enable fewer, simpler desktop 

images and eliminate system conflicts.  This can reduce application regression testing 
and increase virtual desktop density by up to two times. 

 

6. Secure by design. Centralized data, encrypted delivery, a SSL VPN appliance and 

multi-factor authentication ensure that only the correct users connect to their desktops 

and that intellectual property is protected and in compliance with regulations. 

 

7. Service level assurance. Pro-active monitoring identifies performance issues at the 

user level and enables reallocation of resources in real-time to ensure optimal 

performance, high availability and failover.  This ensures high user satisfaction and 

enables IT to meet service level targets. 

 

8. Open architecture. XenDesktop integrates with XenServer, Hyper-V and ESX, and 

works out-of-the-box with desktop appliances.  This ensures no vendor lock-in for 

virtualization or endpoint devices. 
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Evaluation Environment 

This section describes the installation and configuration of an evaluation deployment using 

XenDesktop and Microsoft components, in which all systems are installed in a single domain. 

This evaluation deployment makes use only of features found in the XenDesktop Advanced 

Edition. Although the evaluation deployment is possible with both the Enterprise and Platinum 

editions, features that are unique to either or both of those editions are not used. 

With the experience gained in this deployment, you can extend your installation over multiple 

domains and then add the additional features that are supplied only with Enterprise and 

Platinum editions. 

This document describes an evaluation scenario that focuses on the provision of full-screen-

only desktops. This enables users to experience virtual desktops that are indistinguishable from 

a local desktop. 

The evaluation environment includes the following hardware: 

• pServerOne. A physical server that runs Windows Server 2008 with Hyper-V and 

hosts the XenDesktop infrastructure components. 

• pServerTwo. A physical server that runs Windows Server 2008 with Hyper-V that 

hosts the virtual desktops.  This server also host a VM running SCVMM. 

• Endpoint device(s). One or more computers running Windows Vista or Windows XP. 

In a production environment, you could distribute the infrastructure components to other 

physical devices as necessary, and create multiple servers running Hyper-V to support large 

numbers of virtual desktops. 
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The figure shows the XenDesktop evaluation environment with Microsoft’s Hyper-V and System 
Center Virtual Machine Manager providing the VM infrastructure. 
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Physical Components 

The physical components of the XenDesktop evaluation environment are listed in the following 

table. Physical servers are denoted by the prefix ‘p’ and the virtual machines running on those 

physical servers are denoted by the prefix ‘v’. 

 

Component VMs and Installed Software 

pServerOne 
� A server running the VM infrastructure software, in this 

case, Windows Server 2008 x64 Edition configured with 

Hyper-V.  You assign the name pServerOne during the 

installation. 

� In this evaluation environment, this server collectively 

provides the XenDesktop delivery infrastructure as 

follows: 

� Locally installed – the domain controller running 

Windows Server 2008 with: 

� Active Directory 

� DNS 

� DHCP 

Virtual Machines 

� vDesktopDDC – runs Citrix Desktop Delivery Controller 

on Windows Server 2003, and includes:  

� Citrix Desktop Delivery Controller 

� Access Management Console 

� License Server Console 

� vDesktopPvS – runs the Citrix Provisioning Server on 

Windows Server 2003, and includes: 

� Provisioning Server 

� Provisioning Server SDK 

� Hyper-V guest tools (Integration Services) 

pServerTwo 
� A second server running the same VM infrastructure 

software as pServerOne.  You assign the name 

pServerTwo during the installation. 

Virtual Machines 

� vDesktopVMM – runs Microsoft System Center Virtual 

Machine Manager on Windows Server 2008 x64 Edition 

� This server hosts the VMs on which the virtual desktops 

reside.  During the installation, you create the five XP VM 

desktops with names vDesktop_1 through vDesktop_3 

that endpoints can access. 

Endpoint Device A computer running Windows XP or Windows Vista and the 

Desktop Receiver. 
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XenDesktop Components 

The XenDesktop evaluation environment makes use of the following components: 

 

Component Description 

Microsoft Hyper-V The Hyper-V role enables you to create a virtualized computing 

environment using a technology that is part of Windows Server 

2008.  This virtualized computing environment creates the 

foundation for delivering virtual desktops and offers advance 

management features. 

Microsoft SCVMM System Center Virtual Machine Manager 2008 provides centralized 

administration of virtual machine infrastructure and enables 

increased physical server utilization and rapid provisioning of new 

virtual machines by the administrator and authorized users. 

Citrix Desktop Delivery 

Controller 

A component that manages the connections between users’ 

endpoint devices and the virtual desktops. 

Citrix Provisioning 

Server 

A component that enables you to stream a single desktop image to 

create multiple virtual desktops on one or more servers in a data 

center. This facility greatly reduces the amount of storage required 

compared to other methods of creating virtual desktops. 

XenDesktop Setup 

Wizard 

A tool that automates parts of the creation and delivery of large 

installations of virtual desktops. This wizard integrates Citrix 

components so that system administrators can quickly create 

multiple desktops. 

Virtual Desktop  A desktop operation system (for example, Vista) running on a virtual 

machine that runs on a VM. 

Virtual Desktop Agent Software running on a VM that enables the operating system to 

make its desktop available to another computer (or endpoint device). 

Citrix Desktop Receiver Software running on an endpoint that provides toolbar functionality, 

allowing users to pan and scale virtual desktops inside their local 

desktop. Users can work with more than one desktop by using 

multiple Desktop Receiver connections on the same endpoint 

device. 

Desktop Receiver 

Embedded Edition. 

Software that repurposes computers running Windows XP into 

XenDesktop-ready desktop appliances that can display virtual 

desktops in full-screen-only mode. 
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ICA A communications protocol used between users’ endpoint devices 

and virtual desktops. With ICA, all desktop logic executes on the 

desktop host. Only screen updates, mouse clicks, and keystrokes 

are transmitted to the endpoints. 

For more information about the features of ICA, see the XenApp 

Plugin for Hosted Apps for Windows Administrator’s Guide. 

License server A component that validates licenses for Desktop Delivery Controller 

and Provisioning Server. You install this component when you install 

Desktop Delivery Controller. 

IP Addressing 
For simplicity, the evaluation scenario specifies an isolated LAN environment with an IP 
addressing scheme based on the following assumptions: 

• A simple Ethernet switch is used to connect the hardware. 

• The VMs on pServerOne have manually assigned IP addresses. For reference, these 

IP addresses are listed in the step-by-step procedures. 

• The VMs on pServerTwo providing the virtual desktops are named vDesktop1 through 

vDesktop5. These desktops have IP addresses assigned by DHCP. 

You can define your own IP addresses based on the local environment into which you are 

installing XenDesktop. In this case, replace the IP addresses specified in “XenDesktop 

Administration” on page 17 with addresses appropriate to your own environment. 

System Requirements 

The hardware requirements described in this section relate to the evaluation environment as 

described in “Evaluation Environment” on page 9. 

Recommendations 

� Citrix strongly recommends that you isolate the evaluation environment from your 

production environment. 

� All server-side components must be installed on virtual machines using one of the 

supported virtualization infrastructure types. 

Software Requirements 

This evaluation environment works properly only if the correct versions of the software 

components are installed. This section lists the mandatory versions of the major Citrix products 

and components plus the third-party products, all of which are required to create the 

XenDesktop evaluation environment. 

Citrix Products and Components 

The Citrix XenDesktop components include the following. 

Important: Use only the versions supplied on the installation media and not versions that you 

may have previously acquired.  You may download these components at www.mycitrix.com.  

� Citrix Desktop Delivery Controller 2.1 



XenDesktop with Hyper-V Evaluation Guide  14 

 

 

� Citrix Provisioning Server 5.0 
� Citrix XenDesktop Setup Wizard 
� Citrix Desktop Receiver 10.251 (available on the installation media and from the 

Citrix Web site at http://www.citrix.com/English/ss/downloads. 

Important: Use only the versions supplied on the installation media 
and not versions that you might have previously acquired. 

Products 

You are responsible for sourcing and licensing all non-Citrix products, except for Microsoft .NET 

Framework 3.5.  

Domain Controller (pServerOne) 

� Microsoft Windows Server 2008 x64 Editions 

Provisioning Server (vDesktopDDC) 

� Microsoft Windows Server 2003 with Service Pack 2 

Provisioning Server (vDesktopPvS) 

� Microsoft Windows Server 2008 x64 Editions 
� Microsoft .NET Framework 3.5 

Virtual desktops (vDesktopXX) 

� Windows Vista 

� Windows Vista with or with Service Pack 1  

� Microsoft .NET Framework 3.5 required 

� Windows XP 

� Microsoft Windows XP Professional 32-bit, with Service Pack 3. 
� Microsoft .NET Framework 3.5 required. 

Endpoint devices  

� Windows Vista 

� Microsoft Windows Vista 64-bit Editions with Service Pack 1 Microsoft .NET  
� Microsoft Windows Vista 32-bit Editions with Service Pack 1 Microsoft .NET  

� Windows XP 

� Microsoft Windows XP Professional 64-bit with Service Pack 2 (or higher) 

� Microsoft Windows XP Professional 32-bit with Service Pack 2 (or higher) 

Third-Party VM Infrastructure 

� Microsoft Windows Server 2008 x64 for Hyper-V 

� Can be downloaded here: http://technet.microsoft.com/en-

us/evalcenter/cc137123.aspx  

� Microsoft System Center Virtual Machine Manager 2008 

� Can be downloaded here: 

http://www.microsoft.com/systemcenter/virtualmachinemanager/en/us/trial-

software.aspx  

� Microsoft Hyper-V Integration Services 

� Hyper-V includes a software package that improves integration between the 

physical computer and the virtual machine.  This package contains integration 

services and virtual machine drivers. 
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Installation Time 

You need to allocate sufficient time to install all the components of XenDesktop. Allow 

approximately two days to perform the complete installation. 

Hardware Requirements 

The procedures described in this document assume the following hardware: 

 

Components Specifications 

 
pServerOne 
pServerTwo 

CPU 
Note: Hyper-V is a 64-bit only 

technology and requires a 64-bit 
capable hardware with Intel VT or 
AMD-V technology enabled. 
Processor: Intel Pentium 4, Xeon, 

Core 2 DUO processor; AMD 
Opteron, Athlon 64, Athlon X2, . 
Hardware Data Execution Protection 
(DEP) must be available and be 
enabled. Specifically, you must 
enable Intel XD bit (execute disable 
bit) or AMD NX bit (no execute bit). 

Minimum CPU speed: 1 GHz; 
Recommended: 2 GHz or faster 

Important: If your CPUs do not 

support hardware virtualization, you 

cannot start the VMs.. 
 

Memory 
Minimum 8 GB RAM total (4 GB per 
server). 

 

Hard Disk 
100 GB locally attached storage ( for 
example PATA, SATA, or SCSI) 

NIC 
100 Mbps (megabits per second) or 
faster network interface card (NIC). 

Endpoint devices 
Computers capable of running Windows Vista or Windows 
XP 

Hyper-V supports a broad range of x64 capable hardware devices. Please refer to the 

www.windowsservercatalog.com for the list of supported hardware platforms. An update to the 

latest available BIOS version for your server hardware might be required. Use of other hardware 

platforms could result in some incompatibilities.  

For more information regarding Microsoft’s Hyper-V: 

http://www.microsoft.com/windowsserver2008/en/us/hyperv-

install.aspx#RecommendedHardwareDevices  

For more information regarding Citrix specific requirements, see the relevant documentation for 

the particular XenDesktop component.  
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Installing and Configuring the 

Evaluation 

This section is written explicitly for creating an evaluation environment for the delivery of virtual 

desktops with XenDesktop in which Hyper-V provides the VM hosting infrastructure.  

Overview 

This deployment is a set of sequential tasks, which are numbered in the order in which you 

have to perform them.  

XenDesktop Administration 

Task 1. Installing the VM Infrastructure 

Task 2. Configuring Active Directory for XenDesktop 

Task 3 Creating the Virtual Machines 

Task 4. Installing and Configuring Microsoft SCVMM 2008 

Task 5. Installing Desktop Delivery Controller 

Task 6. Installing and Configuring Provisioning Server 

Task 7. Preparing the Virtual Desktop Image 

Task 8. Preparing and Provisioning Virtual Desktops 

Task 9. Creating Multiple Virtual Desktops 

XenDesktop Endpoint Devices 

Task 1. Preparing the Endpoint Device 

Task 2. Converting the Endpoint Device to Full-Screen-Only Mode 

Task 3. Connecting to a Virtual Desktop from a Thin Client Device 

Task 4. Monitoring Virtual Desktop Usage 
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XenDesktop Administration 

This section describes the procedures you need to perform to create an infrastructure that 

supports virtual desktop delivery using XenDesktop components including Hyper-V. 

Task 1. Installing the VM Infrastructure 

In this task, you install the VM Infrastructure software on the two physical servers (pServerOne 

and pServerTwo). 

To Install Hyper-V on pServerOne (and pServerTwo) 

Microsoft’s Hyper-V is installed as a role on top of Windows Server 2008 x64.  The procedures 

for installing the Hyper-V are almost identical on the two servers, except that you must specify 

different IP parameters in each case.  

Prerequisites 

Hyper-V is only available for x64 editions of Windows Server 2008. If you are using a version of 

Windows Server 2008 that is pre-RTM, you will need to perform a clean install of Windows 

Server 2008 RTM x64 edition on your host system. Hyper-V cannot be enabled on systems 

running inside virtual machines or on x86 versions of Windows Server 2008. 

The RTM update of Hyper-V is available for Windows Server 2008 x64 editions. Hyper-V 

requires an x64-based processor, hardware-assisted virtualization, and hardware data 

execution protection.  

Note:  Any Computer on which you install Hyper-V must have a CPU that supports hardware 

virtualization; see “Hardware Requirements” on page 15. 

 

1. Install Microsoft Server 2008 (x64 Edition) on pServerOne. 

2. Configure pServerOne with the following static network settings: 

Network Settings pServerOne pServerTwo 

IP Address 192.168.1.2 192.168.1.3 

Subnet mask 255.255.255.0 255.255.255.0 

Default gateway 192.168.1.1 192.168.1.1 

Preferred DNS server 192.168.1.2 192.168.1.2 

 

3. Install the latest Windows Updates including Hyper-V (KB950050). 

4. Start Server Manager and add server role Hyper-V 

When you have completed the installation of pServerOne, repeat the procedure 

for pServerTwo, taking into account the differences in networking information. 
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Task 2. Configuring Active Directory for XenDesktop 
Desktop Delivery Controller uses Active Directory to store configuration information and to 
manage the assignment of virtual desktops to users. This section describes how to configure 
Active Directory specifically for XenDesktop. 
 
In this task, you do the following: 

• Create and configure Active Directory on the Domain Controller 

• Create an organizational unit named XenDesktop 

• Create user accounts 

To create and configure Active Directory on the Domain Controller (pServerOne) 
Configure Active Directory on pServerOne, using the following guidelines: 

 
Domain Controller 

 
� In Windows Server 2008, create an Active 

Directory Domain named XenDT.net with 
a single domain controller. 
 

� When creating the new AD forest, set the 

forest and domain functional levels to 

Windows Server 2003. 

 
DNS Server 

 
� Configure Active Directory to include DNS 

server,  which must be configured to have 
both forward and reverse look-up zones 

 
DHCP Server 

 
� DHCP Scope.  Specify a DHCP scope 

named XenDesktop with an address 
range of 192.168.1.20 to 192.168.1.200.  
This enables DHCP to dynamically assign 
IP addresses to the new virtual desktops, 
while protecting the IP Addresses that 
you have already assigned as static. 
 

� DHCP Boot options.  You must 

configure the DHCP boot options after 
installing Citrix Provisioning Server 

 
For more information about Active Directory, DNS, and DHCP, refer to the relevant Microsoft 
documentation. 

Add pServerTwo to the domain 

• On pServerTwo, join the newly created Active Directory Domain. 

To create an organizational unit named XenDesktop  
At the root level, create an organizational unit (OU) named XenDesktop. This OU is used to 

store Desktop Delivery Controller farm configuration. 
 
For more information about Active Directory and creating an OU, refer to the relevant Microsoft 
documentation. 

To create user accounts 
Create five test user accounts named User_1 through User_3, with or without passwords, as 
required. These accounts enable different users to log on to the virtual desktops. 
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Task 3. Creating the Virtual Machines  
In this task, you create the three VMs for your evaluation environment. You configure each of 
these components in later steps.  
 
In this task, you do the following: 

• Create the System Center Virtual Machine Manager VM 

• Create the Desktop Delivery Controller VM 

• Create the Provisioning Server VM 

• Create the BaseDesktop1 VM 

• Add the VMs to the Active Directory Domain 

• Create a Provisioning Server VM template 

• Add virtual machines to the XenDT.net domain 

To create the Desktop Delivery Controller VM on pServerOne 
 

1. Open Hyper-V Manager on pServerOne 
2. Insert the disk containing Windows Server 2003 R2 (x86 edition) in the drive or an ISO 

file can be used. 
3. Right click on pServerOne, select New, Virtual Machine.  The New Virtual Machine 

Wizard should appear, specify the following values for this VM: 

 
 
OS Type 

 

Windows Server 2003 R2 x86 Edition 

 
Specify Name 

 
Name: vDesktopDDC 

 
Assign Memory 

 
768 MB 

 
Configure Network 

 
Select the appropriate (or only) network interface card. 

 
Virtual Hard Disks 

 
8 GB 

 
Installation Options 

 
Install an operation system from a boot CD/DVD-ROM 
or Image file (.iso) 

 
4. On the Completing the New Virtual Machine Wizard page, select Start the virtual 

machine after it is created and click Finish. 

5. The VM should power-on, connect, and present a console window to install the OS. 
 
Note: If not the console for the VM does not open, then in Hyper-V Manager, select 
the new VM, click Connect and install the OS.  

 
6. Once the OS is installed, login to vDesktopDDC. 
7. From the Action menu, select Insert Integration Services Setup Disk and restart 

when prompted. 
8. Configure a static IP address with the following values: 
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To create the Provisioning Server VM on pServerOne 
 

1. Open Hyper-V Manager on pServerOne 
2. Insert the disk containing Windows Server 2003 R2 (x86 edition) in the drive or an ISO 

file can be used. 

3. Right click on pServerOne, select New, Virtual Machine.  The New Virtual Machine 

Wizard should appear, specify the following values for this VM: 
 
OS Type 

 

Windows Server 2003 R2 x86 Edition 

 
Specify Name 

 
Name: vDesktopPvS 

 
Assign Memory 

 
1024 MB 

 
Configure Network 

 
Select the appropriate (or only) network interface card. 

 
Virtual Hard Disks On Windows XP, at least 20 GB 

On Windows Vista, at least 30 GB 

This disk must be large enough to accommodate the 

virtual disk (vDisk) for this VM. 

 

 
Installation Options 

 
Install an operation system from a boot CD/DVD-ROM 
or Image file (.iso) 

 
4. On the Completing the New Virtual Machine Wizard page, select Start the virtual 

machine after it is created and click Finish. 

5. The VM should power-on, connect, and present a console window to install the OS. 
 
Note: If not the console for the VM does not open, then in Hyper-V Manager, select 
the new VM, click Connect and install the OS.  

 
6. Once the OS is installed, login to vDesktopPvS. 

 
IP Address 

 

192.168.1.11 
 
The IP address that you reserved for the Desktop 
Delivery Controller VM 
 

 
Subnet Mask 

 
255.255.255.0 

 
DNS 

 
192.168.1.2 
 
The IP address of the DNS server for your environment 
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7. From the Action menu, select Insert Integration Services Setup Disk and restart 

when prompted. 

8. Configure a static IP address with the following values: 

 
 
 
 
 
 
 
 
 

 

 

To create the System Center Virtual Machine Manager VM on pServerTwo 
 

1. Open Hyper-V Manager on pServerTwo 
2. Insert the disk containing Windows Server 2008 x64 Edition in the drive or an ISO file 

can be used. 
3. Right click on pServerTwo, select New, Virtual Machine.  The New Virtual Machine 

Wizard should appear, specify the following values for this VM: 

 
 
OS Type 

 

Windows Server 2008 x64 Edition 

 
Specify Name 

 
Name: vDesktopVMM 

 
Assign Memory 

 
1024 MB 

 
Configure Network 

 
Select the appropriate (or only) network interface card. 

 
Virtual Hard Disks 

 
20 GB 

 
Installation Options 

 
Install an operation system from a boot CD/DVD-ROM 
or Image file (.iso) 

 
4. On the Completing the New Virtual Machine Wizard page, select Start the virtual 

machine after it is created and click Finish. 

5. The VM should power-on, connect, and present a console window to install the OS. 
 
Note: If not the console for the VM does not open, then in Hyper-V Manager, select 
the new VM, click Connect and install the OS.  

 
6. Once the OS is installed, login to vDesktopVMM. 
7. From the Action menu of the VM, select Insert Integration Services Setup Disk 

8. In the Upgrade Hyper-V Integration Services window, click OK and restart when 

prompted.  

 
IP Address 

 

192.168.1.12 
 
The IP address that you reserved for the Desktop 
Delivery Controller VM 

 
Subnet Mask 

 
255.255.255.0 

 
DNS 

 
192.168.1.2 
 
The IP address of the DNS server for your environment 
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9. Configure a static IP address with the following values: 

 

 
 
 
 
 
 
 
 
 
 
 
 

To create the BaseDesktop1 VM on pServerTwo 
 

1. Open Hyper-V Manager on pServerTwo 
2. Insert the Windows XP or Windows Vista installation disc in the drive or an ISO file can 

be used. 
3. Right click on pServerTwo, select New, Virtual Machine.  The New Virtual Machine 

Wizard should appear, specify the following values for this VM: 

 
 
OS Type Windows XP with SP3 (x86) or 

Windows Vista with SP1 (x86) 

 

 
Specify Name 

 
Name: BaseDesktop1 

 
Assign Memory 512 MB for Windows XP 

768 MB for Vista 

 

 
Configure Network 

 
Select the appropriate (or only) network interface card. 

 
Virtual Hard Disks 8 GB for Windows XP 

16 GB for Vista 

 

 
Installation Options 

 
Install an operating system from a boot CD/DVD-ROM 
or Image file (.iso) 

 
4. On the Completing the New Virtual Machine Wizard page, do not select Start the 

virtual machine after it is created and click Finish. 

 

 
IP Address 

 

192.168.1.10 
 
The IP address that you reserved for the System Center 
Virtual Machine Manager VM 
 

 
Subnet Mask 

 
255.255.255.0 

 
DNS 

 
192.168.1.2 
 
The IP address of the DNS server for your environment 
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5. In Hyper-V Manager, right click on PvS VM Template and click Settings. 

 
Note: Be sure the VM is turned off. 

 
6. Under Hardware, select Network Adapter and then click Remove. 
7. Under Hardware, select Add Hardware, then select Legacy Network Adapter, and 

click Add 
8. Under Legacy Network Adapter, Network:, select the appropriate NIC from the drop 

down box. 
9. Click OK to accept the changes. 

10. In Hyper-V Manager, power-on and connect to the virtual machine (BaseDesktop1) 
console. 

11. Using the VM console, install the OS. 
12. From the Action menu, select Insert Integration Services Setup Disk and restart 

when prompted. 
13. Use a DHCP provided IP address. 
14. Apply Windows Updates 

a. If Windows XP was installed, be sure that Service Pack 3 is installed. 
b. If Windows Vista was installed, be sure that Service Pack 1 is installed. 

Add virtual machines to the XenDT.net domain 

Add the following VMs as members of the domain XenDT.net.  

• vDesktopDDC 

• vDesktopPvS 

• vDesktopVMM 

• BaseDesktop1 

Task 4. Installing and Configuring Microsoft System Center 

Virtual Machine Manager 2008 

In this task, you will install SCVMM on vDesktopVMM located on pServerTwo 

To install SCVMM 2008 on vDesktopVMM 

The download for SCVMM 2008 is available here: 

http://www.microsoft.com/systemcenter/virtualmachinemanager/en/us/trial-software.aspx   

 
1. Be sure that vDesktopVMM is added to the domain. 

2. Log into vDesktopVMM using a domain administrator account. 

3. Insert the disk containing installation media for SCVMM 2008 in the drive or an ISO file 
can be used.  Using the VM console, attach the physical CD/DVD drive, or optional 
ISO file, by clicking on the File menu and Settings.  Select DVD Drive and choose the 

desired option under Media. 
4. Run the Setup.exe to start the installation process. 
5. Under SETUP, select VMM Server. 

6. On the License Terms page, read and accept the Microsoft license terms, click Next. 

7. On the Microsoft Update page, accept the default setting and click Next. 

8. On the Customer Experience Improvement Program page, select your preference 

and click Next. 

9. On the Product Registration page, enter your user name and company information 

and click Next. 

10. On the Perquisites Check page, the following should be displayed All required 

software and hardware components are present.  If so, then click Next. 

11. On the Installation Location page, accept the default installation path and click Next. 
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12. On the SQL Server Settings page, change to Install SQL Server 2005 Express 

Edition SP2, accept the default database location path and click Next. 

13. Accept the default settings for the remaining pages and click Install. 

14. Upon completion, the status should state Virtual Machine Manger Server 

installation has completed successfully.  If so, then click Close.  

Task 5. Installing Desktop Delivery Controller 
The Desktop Delivery Controller installation automatically installs all the prerequisite Desktop 
Delivery Controller components. For installing Terminal Server and Internet Information 
Services (IIS), the installation program prompts you to insert the Windows Server 2003 
installation disc at the appropriate time.  
 
In this task, you do the following: 
 

• Install SCVMM Administrative Console 

• Configure the SCVMM Administrative Console 

• Install Desktop Delivery Controller 

• Run the XenDesktop Active Directory configuration wizard 

• Configure the Access Management Console 

• Install the XenDesktop license 

To install SCVMM Administrative Console 
1. Be sure that vDesktopDDC is added to the domain. 

2. Log into vDesktopDDC using a domain administrator account. 

3. Download and install Powershell 1.0 from here: 
http://www.microsoft.com/downloadS/details.aspx?familyid=10EE29AF-7C3A-4057-
8367-C9C1DAB6E2BF&displaylang=en  
 
Note: Powershell is a requirement for SCVMM 2008.   

 
Tip: If you experience an error while attempting to install Powershell, try logging into 

vDesktopDDC using a local administrator account and reattempt the installation. - 
Remember to log back into the system using a domain administrator account before 
proceeding. 
 

4. Insert the disk containing installation media for SCVMM 2008 in the drive or an ISO file 
can be used. 

5. Run the Setup.exe to start the installation process. 
6. Under SETUP, select VMM Administrator Console. 

7. If .NET Framework 2.0 is not installed, then click OK and install it.  If not prompted to 

install it, then continue to the next step. 

8. On the License Terms page, read and accept the Microsoft license terms, click Next. 

9. On the Microsoft Update page, accept the default setting and click Next. 

10. On the Customer Experience Improvement Program page, click Next. 

11. On the Perquisites Check page, the following should be displayed All required 

software and hardware components are present.  Click Next. 

12. On the Installation Location page, accept the default installation path and click Next. 
13. On the Port Assignment page, accept the default port and click Next. 
14. On the Summary of Settings page, click Install. 
15. Upon completion, the status should state Virtual Machine Manger Administrator 

Console installation has completed successfully.  If so, then click Close.  

To configure SCVMM Administrative Console 
1. On vDesktopDDC, open the SCVMM Admin Console, click Start > All Programs > 

Microsoft System Center > Virtual Machine Manager 2008 > Virtual Machine 
Manager Administrator Console. 
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2. In the Connect to Server window, change the server name to vDesktopVMM:8100 
and click Connect. 

3. Under Actions, Virtual Machine Manager, click Add host. 
4. On the Select Host Location page, leave the default setting and enter the domain 

administrator password.  Click Next to continue. 
5. On the Select Host Servers page, enter pServerTwo and click Add.  Click Next to 

continue. 
6. In the Virtual Machine Manager window, click Yes. 
7. On the Configuration Settings page, leave the default setting and click Next to 

continue. 
8. On the Virtual Machine Paths page, leave the default setting and click Next to 

continue. 
9. On the Summary page, click Add Hosts. 

10. After the host is added, close the SCVMM Admin Console. 

To install Desktop Delivery Controller software 
 
Note: The SCVMM Administrator Console needs to be installed prior to this task. 

 
1. Log into vDesktopDDC using a domain administrator account. 

2. On pServerOne, insert the Desktop Delivery Controller installation disc or an ISO file 
can be used.  Using the VM console, attach the physical CD/DVD drive, or optional 
ISO file, by clicking on the File menu and Settings.  Select DVD Drive and choose the 

desired option under Media. 
 
Note: If auto run is not enabled and the installation window does not appear, run 
autorun.exe from the disc. 

 
3. In the Citrix Desktop Delivery Controller 2.1 installation window, select Install 

Server Components. 
4. Read and accept the license agreement, and click Next. 
5. On the Select Components page, leave all options selected and click Next. 
6. On the Create or Join a Farm page, select Create new farm, type XenDtFarm and 

click Next. 

A farm name can have up to 32 characters, including spaces. The following characters 
are not allowed: \/ ; : .* ? = < > | [ ] ( ) ' " # 

7. On the Specify Farm Edition page, select the XenDesktop edition that you are using, 
such as Platinum and click Next 

8. On the Optional Server Configuration page, click Next. 
9. On the Start Installation page, click Next. 

10. Follow the on-screen prompts.  When prompted, provide the Windows Server 2003 R2 
x86 installation media. 
 
Note: When the installation program prompts you to restart the server, you must log on 

with the same user ID and password that you used to start the installation. 
 

11. On the Setup Complete page, leave both check boxes selected and click Finish. 

Both the Active Directory configuration wizard and the License Management Console 
start up. Follow the instructions in the next two sections to configure these 
components. 

To run the XenDesktop Active Directory configuration wizard 
Use this wizard to configure the default population of the Active Directory organizational unit-
specifically for running the Desktop Delivery Controller. This wizard starts automatically after 
you complete the previous procedure. 
 

1. On the Active Directory Configuration Wizard page, click Next. 
2. On the Configure Farm OU in Active Directory page, click Browse and navigate to 

the XenDesktop OU that was created in Task 4.  Click OK to close the navigation 
window. Click Next. 

3. On the next page, click Finish and then, on the Summary page, click Close. 
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4. When prompted to start the Access Management Console, click Yes. 

Leave the console running for the next procedure. 

To configure the Access Management Console 
When the Access Management Console starts for the first time, the Configure and run discovery 
wizard opens. 

1. On the Welcome page, click Next. 
2. On the Select Product or Components page, ensure that all the check boxes are 

selected and click Next 
3. On the Select Controllers page, click Add Local Computer and click Next. 
4. On the Preview Discovery page, click Next.. 
5. On the Discovery Progress page, wait until the discovery is complete and click 

Finish. 

In the Access Management Console, the vDesktopDDC VM is added to the navigation 
pane under Citrix Resources > Desktop Delivery Controllers > XenDtFarm > 
Controllers > vDesktopDDC. 

6. Close the Access Management Console window. 

Tip: To reopen the Access Management Console at any time from the Windows Start menu, 
click Start > All Programs > Citrix > Management Consoles > Access Management 
Console. 

To install the XenDesktop license 
To be able to use either Desktop Delivery Controller or Provisioning Server, you must install and 
activate the XenDesktop license. The License Management Console should still be open from 
an earlier procedure.  XenDesktop evaluation licenses can obtained from www.mycitrix.com.  

1. In the License Management Console, click the Configuration tab, and then click 
Step 2 Copy license file to this license server. 

2. On the Upload license File page, click Browse and navigate to the location of your 

XenDesktop license file.  <Use the license file downloaded from MyCitrix.com> 
3. Click Open to select the required license file. 
4. Click Upload to add the license file to the License Management Console. 
5. Close the License Management Console window. 

 
Tip: To reopen the License Management Console at any time from the Windows Start menu, 
click Start > All Programs > Citrix > Management Consoles > License Management 
Console. 

Task 6. Installing and Configuring Provisioning Server 
In this task, you install and configure the Provisioning Server and its related components, 
including the XenDesktop Setup Wizard. 
In this task, you do the following: 

• Install Microsoft .NET Framework 3.5 

• Install SQL Server 2005 Express 

• Install SCVMM Administrative Console 

• Configure the SCVMM Administrative Console 

• Install Provisioning Server 

• Configure Provisioning Server 

• Install the XenDesktop Setup Wizard 

• Create the Provisioning Server virtual disk (vDisk) 

• Configure DHCP boot options 66 and 67 on the pServerOne 

To install Microsoft .NET Framework 3.5 
1. Log into vDesktopPvS using a domain administrator account. 
2. On pServerOne, insert the Desktop Delivery Controller disc or an ISO file can be used. 
3. On the Provisioning Server VM (vDesktopPvS), navigate to the folder 

win2k3\en\Support\DotNet35, and run dotnetfx35.exe from this location. 

4. Follow the on-screen instructions to complete the installation. 
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To install SQL Server 2005 Express 
This procedure installs SQL Server 2005 Express on the vDesktopPvS VM located on 
pServerOne. 

 

Note: Although it is possible to install the Provisioning Server database on vDesktopPvS 

alongside Provisioning Server, Citrix does not recommended doing so as this configuration can 
cause poor distribution during load balancing.  However, for this evaluation, installing SQL 
Server Express on vDesktopPvS is acceptable. 
 

1. Log into vDesktopPvS using a domain administrator account. 
2. On pServerOne, insert the Provisioning Server for Desktops disc or an ISO file can be 

used. 
3. On the Provisioning Server VM (vDesktopPvS), navigate to the folder SQL Server 

2005 Express, and run SQLEXPR32.EXE from this location. 
4. On the End User License Agreement page, read the terms and select I accept the 

licensing terms and conditions, click Next. 
5. On the Installing Prerequisites page, select Next. 
6. On the Welcome to the Microsoft SQL Server Installation Wizard page, click Next. 

 

Note:  You should receive 13 total success results with no errors or warnings. 

 

7. On the System Configuration Check page, click Next. 
8. On the Registration Information page, click Next. 
9. On the Feature Selection page, accept the default settings and click Next. 
10. On the Authentication Mode page, accept the default setting and click Next. 
11. On the Configuration Options page, accept the default setting and click Next. 
12. On the Error and Usage Report Settings page, accept the default settings and click 

Next. 
13. On the Ready to Install page, click Install. 
14. On the Setup Progress page, click Next. 
15. On the Completing Microsoft SQL Server 2005 Setup page, click Finish. 
16. Restart vDesktopPvS before continuing. 

 

To install SCVMM Administrative Console 
1. Be sure that vDesktopPvS is added to the domain. 

2. Log into vDesktopPvS using a domain administrator account. 

3. Download and install Powershell 1.0 from here: 
http://www.microsoft.com/downloadS/details.aspx?familyid=10EE29AF-7C3A-4057-
8367-C9C1DAB6E2BF&displaylang=en  
Powershell is a requirement for SCVMM 2008. 
 
Tip: If you experience an error while attempting to install Powershell, try using a local 

administrator account and reattempt the installation.  Remember to log back into the 
system using a domain administrator account before proceeding. 
 

4. Insert the disk containing installation media for SCVMM 2008 in the drive or an ISO file 
can be used. 

5. Run the Setup.exe to start the installation process. 
6. Under SETUP, select VMM Administrator Console. 

7. If .NET Framework 2.0 is not installed, then click OK and install it.  If not prompted to 

install it, then continue to the next step. 

8. On the License Terms page, read and accept the Microsoft license terms, click Next. 

9. On the Microsoft Update page, accept the default setting and click Next. 

10. On the Customer Experience Improvement Program page, click Next. 

11. On the Perquisites Check page, the following should be displayed All required 

software and hardware components are present.  Click Next. 

12. On the Installation Location page, accept the default installation path and click Next. 
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13. On the Port Assignment page, accept the default port and click Next. 
14. On the Summary of Settings page, click Install. 
15. Upon completion, the status should state Virtual Machine Manager Administrator 

Console installation has completed successfully.  If so, then click Close. 

To configure SCVMM Administrative Console 
1. On vDesktopPvS, open the SCVMM Admin Console, click Start > All Programs > 

Microsoft System Center > Virtual Machine Manager 2008 > Virtual Machine 
Manager Administrator Console. 

2. In the Connect to Server window, change the server name to vDesktopVMM:8100 
and click Connect. 

3. Verify that pServerTwo is added, close the SCVMM Admin Console. 

To install Provisioning Server 
This procedure installs Provisioning Server on the vDesktopPvS virtual machine located on 
pServerOne. 

1. Log into vDesktopPvS using a domain administrator account. 

2. On pServerOne, insert the Provisioning Server for Desktops installation disc or an ISO 
file can be used.   

3. On the startup window, click Install Server for 32 bit Platform. 
4. On the Welcome to the Installation Wizard for Citrix Provisioning Server page, 

click Next. 
5. Read and accept the license agreement, and click Next. 
6. On the Customer Information page, type your customer information, accept the 

default option Anyone who uses this computer (all users) and click Next. 
7. On the Destination Folder page, accept the default location, and click Next. 
8. On the Setup Type page, select Complete and click Next. 
9. On the Ready to Install the Program page, click Install. 
10. On the Installation Wizard Completed page, click Finish. 

The Provisioning Server Configuration wizard starts automatically following installation. 
The next section takes you through this wizard. 

Note:  Although Provisioning Server does not require that you restart the server after 

installing the product software, in some instances a Microsoft message may appear 
requesting a restart. If this message appears, complete the task “To configure 
Provisioning Server” before restarting the server. 

To configure Provisioning Server 
1. On the Provisioning Server Configuration Wizard page, click Next. 
2. On the DHCP services page, select The service that runs on another computer 

and click Next. 
3. On the PXE Services page, accept the default setting The service that runs on this 

computer and click Next. 
4. On the Farm Configuration page, accept the default setting Create farm and click 

Next. 
5. On the Database Server page, click Browse, select VDESKTOPPVS, click OK, and 

click Next. 
6. On the New Farm page, accept the default settings and click Next. 
7. On the User account page, accept the default settings and click Next. 
8. On the License server page, specify the license server name vDesktopDDC, accept 

the default value for the port (27000), and click Next. 
9. On the Streaming Services page, if you have more than one network interface card 

(NIC), select the appropriate card, otherwise, accept the defaults. Click Next. 
10. On the TFTP Option and Bootstrap location page, select Use the Provisioning 

Server TFTP service, accept the default location, and click Next. 
11. On the Stream Servers Boot List page, ensure the IP address of the Provisioning 

Server VM is displayed, and click Next. 
 
Note: DHCP automatically provides the subnet mask and gateway information. 
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12. On the Finish page, confirm your configuration selections, ensure that Automatically 
Start Services is selected, and click Finish. 

13. Click Done when the configuration process completes. 

To install the XenDesktop Setup Wizard 

1. Log into vDesktopPvS using a domain administrator account. 

2. On pServerOne, insert the XenDesktop Component disc or an ISO file can be used. 
3. On the Provisioning Server VM (vDesktopPvS), navigate to the folder D:\XenDesktop 

Setup Tool and run Setup.exe from this location 
4. On the Welcome page, click Next. 
5. On the End-User Agreement page, read and accept the terms. Click Next. 
6. On the Destination Folder page, accept the default path. Click Next. 
7. On the Ready to Install XenDesktop Setup Wizard page, click Install. 
8. On the Completed XenDesktop Setup Wizard Installer page, click Finish. 

To create the Provisioning Server virtual disk (vDisk) 
1. Log into vDesktopPvS using a domain administrator account. 
2. Create a folder on the root of the C drive of vDesktopPvS named vDisk. 
3. On the vDesktopPvS VM, click Start > All Programs > Citrix > Provisioning Server 

> Provisioning Server Console. The console opens. 
4. In the Provisioning Server Console, click Action and Connect to Farm. 
5. In the Server Information window, enter vDesktopPvS for the name and click 

Connect. 
6. In the left pane of the console, right-click the Stores folder and select Create store. 
7. In the Store Properties window, select the General tab and enter XDStore for the 

Name. 
8. In the Store Properties window, select the Paths tab and enter C:\vDisk for the 

Default store path.  Click Add, enter C:\vDisk for the Cache path and click OK.  
9. In the Store Properties window, select the Servers tab and select 

XENDESKTOPPVS for the Servers that provide this store setting.  Click OK. 

10. In the left pane of the console, right-click the new store you just created and select 
Create vDisk. 

11. On the Create vDisk window, specify the following values and click OK: 

Filename vDisk1 

Description Master Virtual Desktop Disk 

Disk Size 8192 MB (Windows XP) 

16384 MB (Windows Vista) 

 

VHD format Dynamic 

 
Note: In the Disk name and Description fields you must use only standard printable 

ANSII characters. If you use any extended characters (for example, Euro sign) or 

DBCS characters (for example, Hiragana characters) in these fields, the Setup Wizard 

will be unable to create the vDisk. 

 

12. In the details pane of the console, right-click vDisk1, select Properties, and click the 
Edit file properties button. 

13. In the vDisk File Properties window, click the Options tab, select Active Directory 
machine account password management, and click OK.  The click OK again. 



 

14. In the left pane of the console, navigate to the 
VDESKTOPPVS

15. In the 

password support

When prompted 

16. In the details pane of the console, right

 

 

17. In the 

To configure DHCP boot options 66 and 67 on the 
1. Log into 
2. On the Domain Controller

DHCP 
3. In the navigation pane, expand the server tree and select 
4. From the 
5. In the 
6. Enable the option 

address of vDesktopPvS). Click 
7. Enable the option 

ARDBP32.bin

 

Your DHCP configuration now
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In the left pane of the console, navigate to the Servers folder for the site, right
VDESKTOPPVS, and select Properties. 
In the Server Properties window, click on the Options tab, select 

password support, accept the default value for the number of days, and click 

When prompted t restart the Provisioning Server Streaming Service, click 

In the details pane of the console, right-click vDisk1 and select 

a. On the Provisioning Server VM (vDesktopPvS), open 

b. Under Devices with Removable Storage, right-click the 
(E:) that is displayed, and click Format. 

c. Format the vDisk as an NTFS disk. 

 

Caution: Format only the removable disk. Do not format any drive listed in the 

Hard Disk Drives section. 

 

In the details pane of the console, right-click vDisk1 and select 

To configure DHCP boot options 66 and 67 on the pServerOne
Log into pServerOne using a domain administrator account. 
On the Domain Controller, click Start > All Programs > Administrative Tools 
DHCP to open the DHCP Management Console on the domain controller.
In the navigation pane, expand the server tree and select Server Options
From the Action menu, select Configure Options.  
In the Server Options dialog box, click the General tab.  
Enable the option 066 Boot Server Host Name, and type 192.168.1.12 
address of vDesktopPvS). Click Apply. 
Enable the option 067 Bootfile Name, specify the corresponding value as 
ARDBP32.bin, and click OK.  

Your DHCP configuration now looks like this: 
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folder for the site, right-click 

tab, select Enable automatic 

, accept the default value for the number of days, and click OK.  

Service, click OK. 

and select Mount vDisk. 

On the Provisioning Server VM (vDesktopPvS), open My Computer. 

 

click the Removable Disk 

Format only the removable disk. Do not format any drive listed in the 

and select Unmount vDisk. 

pServerOne 
 

Administrative Tools > 
to open the DHCP Management Console on the domain controller. 

Server Options. 

192.168.1.12 (the IP 

, specify the corresponding value as 
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Task 7. Preparing the Virtual Desktop Image  
You must install a Virtual Desktop Agent on all virtual desktops to which users connect. This 
agent enables users to make an ICA connection to their virtual desktops. To prepare for this, 
you install the agent on the BaseDesktop1 VM so that later on, when you image BaseDesktop1 
to the Provisioning Server vDisk, the agent is copied to the vDisk at the same time. 
 
In this task, you do the following: 

• Install the Virtual Desktop Agent on the BaseDesktop1 VM 

• Customize the Desktop for Your Users 

• Configure Automatic Access to XenApp Provided Applications 

To install the Virtual Desktop Agent on the BaseDesktop1 VM 
1. In Hyper-V Manager, connect to BaseDesktop1. A new window should appear with 

the BaseDesktop1 VM console. 
2. Verify that BaseDesktop1 is running. The VM must be running to complete this 

procedure. 
3. Log into BaseDesktop1 using a domain administrator account. 
4. On pServerOne, insert the Desktop Delivery Controller installation disc or an ISO file 

can be used.   
5. In the startup window, click Install Virtual Desktop Components. 

 

Note: The installation program prompts you to install .NET 3.5 Framework if it is not 

already installed. 

 

6. On the Welcome to the Citrix Virtual Desktop Agent Setup Wizard page, click 
Next. 

7. Read and accept the license agreement, and click Next. 
8. On the Port Number page, accept the default port number, 8080, and click Next. 

 

Note: The standard session reliability and ICA ports are used by the client device to 

connect to the Virtual desktop; you cannot configure these ports as part of the virtual 

desktop installation process. 

 

9. If the Windows firewall is switched on, the Windows Firewall Configuration page 
appears; in this case, select Automatically configure Windows firewall and click 
Next. 

10. On the Farm selection page, select the check box Select farm now, and choose 
XenDtFarm from the list of farms. 

11. On the Ready to Install page, click Install.  
12. When the installation is complete, click Finish. Restart the virtual desktop for the 

configuration changes to take effect. 

Customizing the Desktop for Your Users 

At this stage of the installation process you can optionally perform additional 
customizations to the virtual desktop image, depending on your users’ requirements. 

Configuring Automatic Access to XenApp-Provided Applications 

If you have either the Enterprise or the Platinum editions of XenDesktop, you can install 
XenApp and configure it to provide applications for delivery to a user’s desktop. 

If virtual desktops have App Receiver installed, a user can automatically log into XenApp 

and use its hosted applications. To do this, you have to add App Receiver to the virtual 
desktop image so that it gets built into the vDisk that is used for the virtual desktops. 

For more information, refer to the XenApp (Presentation Server) documentation, available 

on http://support.citrix.com. 
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Configuring Microsoft Application Virtualization (App-V) with XenDesktop 

If virtual desktops have Microsoft Application Virtualization Desktop Client installed, a 

user can automatically log into the App-V Streaming Server and use its streamed 
applications. To do this, you have to add App-V Desktop Client to the virtual desktop image 
(BaseImage1) so that it gets built into the vDisk that is used for the virtual desktops. 

For more information about App-V, go to: 
http://www.microsoft.com/systemcenter/appv/default.mspx 

http://download.microsoft.com/download/f/7/8/f784a197-73be-48ff-83da-
4102c05a6d44/MSAppVirt45Trial_Guide_Final.docx  

Task 8. Preparing and Provisioning Virtual Desktops 
In this task, you do the following: 

• Add BaseDesktop1 to the Provisioning Server database 

• Install a target device for the 32 bit platform on the BaseDesktop1 VM 

• Image BaseDesktop1 to the Provisioning Server virtual disk 

• Set Virtual Disk Access Mode to Standard Image 

To add BaseDesktop1 to the Provisioning Server database 
1. Power off the VM BaseDesktop1  
2. In Hyper-V Manager, right-click on BaseDesktop1 and click Settings. 
3. In the left pane of the Settings for Base Desktop1 window, select BIOS and move 

Legacy Network Adapter to the top of the Startup Order list. 
4. In the left pane of the Settings for BaseDesktop1 window, click Legacy Network 

Adapter and make a note of the MAC address for the BaseDesktop1. 

5. Restart the BaseDesktop1 VM. 
6. In the VM console, press any key to boot to the OS. 
7. On the Provisioning Server VM (vDesktopPvS), click Start > All Programs > Citrix > 

Provisioning Server > Provisioning Server Console. 
8. In the left pane of the console, navigate to the Device Collections folder for the site, 

right-click the Collection, and select Create Device. 
9. Specify the device name BaseDesktop1 and the description Master virtual desktop 

image. 
10. Type the MAC address of BaseDesktop1 that was noted in step 4 and click OK. 
11. In the left pane of the console, navigate to Collection folder right-click the new device 

(BaseDesktop1) and select Properties. 
12. In the Target Devices Properties window, select Hard Drive from the Boot from 

dropdown list. 
13. In the Target Devices Properties window, select the vDisks tab, under vDisks for 

this Device click Add, and select XDStore\vDisk1.  Click OK and then click OK 

again. 

 

Note: You can confirm that the vDisk has been successfully created at the end of the next 

procedure. 

To install a target device for the 32 bit platform on the BaseDesktop1 VM 

1. Log into BaseDesktop1 using a domain administrator account. 

2. On pServerTwo, insert the Provisioning Server disc or an ISO file can be used. 
3. On the Provisioning Server start-up window, click Install Target Device for 32 bit 

Platform. 
4. On the Welcome to the Installation Wizard for Citrix Provisioning Server Target 

Device page, click Next. 
5. Read and accept the license agreement, and click Next. 
6. On the Customer Information page, enter your information, accept the default option, 

Anyone who uses this computer (all users), and click Next. 
7. On the Destination Folder page, accept the default location and click Next. 



 

8. On the 

9. Restart BaseDesktop1 when prompted.
10. On the I

when prompted.
11. Once restarted, log into BaseDesktop1.

The vDisk is now mapped to BaseDesktop1, and a vDisk icon appears in the Windows 
notification area.

12. Double
13. In My Computer

To image BaseDesktop1 to the Provisioning Server virtual disk
1. On the BaseDesktop1 VM, click 

Provisioning Server Image Builder

opens.
2. On the 

Optimization Tool dialog box opens.
 

 
3. Leave all check boxes selected and click 
4. On the 

drive to the drive letter of the new hard disk drive and click 

 
The destination drive maps to the vDisk you created in your Pro

Note: 
Disk Drives

Storage.
 

5. Ensure that the checkbox 
building image 

6. On the 
7. When the client image build is complete, click 
8. Click 

complete.
9. Shutdown the BaseDesktop1 VM.

 
Note: 

patches or software, and rebuild your vDisk in the same way.
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On the Ready to install the program page, click Install. 

Restart BaseDesktop1 when prompted. 
On the Installation Wizard completed page, click Finish and restart BaseDesktop1 

when prompted. 
Once restarted, log into BaseDesktop1. 
The vDisk is now mapped to BaseDesktop1, and a vDisk icon appears in the Windows 
notification area. 

 
Double-click the vDisk icon and confirm that the vDisk status is 

My Computer, make a note of the new drive letter (typically, the letter is 

To image BaseDesktop1 to the Provisioning Server virtual disk
On the BaseDesktop1 VM, click Start > All Programs > Citrix Provisioning Server 
Provisioning Server Image Builder. The Provisioning Server Image Builder wizard 

opens. 
On the Device Image Builder page, click Optimize. The Provisioning Server Device 

Optimization Tool dialog box opens. 

Leave all check boxes selected and click OK. 
On the Device Image Builder page, use the Browse button to set the destination 
drive to the drive letter of the new hard disk drive and click OK

The destination drive maps to the vDisk you created in your Pro

Note: In My Computer on BaseDesktop1, the vDisk appears as a disk under 
Disk Drives in My Computer, and as a device under Devices with Removable 

Storage. 

Ensure that the checkbox Delete all files and folders in destination path before 
building image is selected and click Build.  
On the Confirm Build details page, click Yes.  
When the client image build is complete, click OK. 
Click Close.  Disregard this step if the VM restarts after the imaging build process is 

complete. 
Shutdown the BaseDesktop1 VM. 

Note: You can restart the BaseDesktop1 VM at any time, for example, to add new 

patches or software, and rebuild your vDisk in the same way.
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and restart BaseDesktop1 

The vDisk is now mapped to BaseDesktop1, and a vDisk icon appears in the Windows 

and confirm that the vDisk status is Active. 
, make a note of the new drive letter (typically, the letter is E.) 

To image BaseDesktop1 to the Provisioning Server virtual disk 
Citrix Provisioning Server > 

. The Provisioning Server Image Builder wizard 

. The Provisioning Server Device 

 

button to set the destination 
OK.  

The destination drive maps to the vDisk you created in your Provisioning Server VM. 

In My Computer on BaseDesktop1, the vDisk appears as a disk under Hard 
, and as a device under Devices with Removable 

Delete all files and folders in destination path before 

r the imaging build process is 

You can restart the BaseDesktop1 VM at any time, for example, to add new 

patches or software, and rebuild your vDisk in the same way. 
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To set Virtual Disk Access Mode to Virtual Image 
1. On the vDesktopPvS VM, click Start > All Programs > Citrix Provisioning Server > 

Provisioning Server Console. 
2. In the left pane of the console, navigate to the vDisk Pool folder for the site, right-click 

vDisk1 in the details pane, and select Properties, and click Edit file properties. 
3. In the vDisk File Properties window, select the Mode tab and, under Access Mode, 

select Standard Image. Click OK and then click OK again. 
 

Tip: If the disk is locked, right-click vDisk1 in the details pane of the console, select 
Manage Locks, click Remove Locks and then click Close. 

Task 9. Creating Multiple Virtual Desktops 
Create the desktop VMs from a single VM image.  
In this task, you do the following: 

• Create multiple virtual desktops 

• Modify the idle desktop count 

To create multiple virtual desktops on pServerTwo 
 

1. On the vDesktopPvS VM, click Start > All Programs > Citrix Provisioning Server > 
XenDesktop Setup Wizard. 

2. On the Welcome to the XenDesktop Setup Wizard page, click Next. 
3. On the Desktop Farm page, select XenDTFarm from the list and click Next. 
4. On the Hosting Infrastructure page, select Microsoft virtualization, specify the 

server vDesktopVMM.XenDT.net, and click Next. 

5. Specify credentials appropriate to the VM infrastructure (XenDT\administrator) and 
click OK. 

6. On the Virtual Machine Template page, select BaseDesktop1 and click Next. 
7. On the Virtual Disk (vDisk) page, select vDisk1 and click Next. 
8. On the Virtual Desktops page, type the following values and click Next. 

Number of desktops 3 

Common name vDesktop 

Start from 1 

These values create five desktops, named vDesktop1 to vDesktop3. 
9. On the Organizational Unit Location page, select Use default OU.  Click Next. 
10. On the Desktop Group page, click Create new desktop group and type the name 

XDgroup for the new desktop group.  Ensure that the Allow immediate access check 
box is selected and click Next. 

11. On the Desktop Creation page, ensure the details that you entered are correct and 
click Next to create the desktops. 

12. Wait until the Summary page appears and then click Finish. 

The following changes have been made to your systems: 

• The VMs vDesktop1 through vDesktop3 are visible in both Hyper-V 

Manager and the Provisioning Server Console 

• The VMs are added to the domain and appear under the Computers 

container in Active Directory 

• A desktop group named XDGroup has been created and appears in 

the Access Management Console on the Desktop Delivery Controller 
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To modify the idle desktop count 
Desktop Delivery Controller manages the number of virtual desktops that are idle, based on the 
time of day. The idle settings enable administrators to control the number of virtual desktops 
that are started and ready for access at any given time.  
 
The XenDesktop Setup Wizard automatically configures and optimizes the idle pool setting in 
the desktop group based on the number of virtual desktops you created.  However, you may 
want to change the default settings. 
 

1. In the vDesktopDDC VM, click Start > All Programs > Citrix > Management 
Consoles > Access Management Console. 

2. In the left pane, navigate to Citrix Resources > Desktop Delivery Controller > 
XenDtFarm > Desktop Groups, and right-click the XenDesktop group (XDgroup). 

3. Click Properties. The Desktop Group Properties page appears. 
4. Click Idle Pool Settings in the left pane. 
5. In the Idle Desktop Count section, modify the settings as follows: 

Business hours 3 

Peak time 3 

Out of hours 1 

 
6. Click Apply to save your settings and then click OK. 

 
Note: You can use Hyper-V Manager to see which VMs are started. If your local time 

is within the business hours, you see that three VMs (vDesktop_1, vDesktop_2, and 
vDesktop_3) have been started. If you are outside business hours, only one VM is 
started. 

  



XenDesktop with Hyper-V Evaluation Guide  36 

 

 

XenDesktop Endpoint Devices 
You can configure user access to virtual desktops in two ways, depending on the needs of your 
users: 

 

• Window view mode. Users log on to their local desktops and view virtual desktops 

using the Desktop Receiver user interface. Virtual desktops appear as windows with 
toolbars, so that users have full control of their virtual desktop windows. 
This configuration is suitable for users who need local access to multiple desktops or 
remote access to desktops. Typically, these users are knowledge workers performing 
complex, non-repetitive tasks who need the flexibility that this mode brings. 

• Full-screen-only mode. Users log on to their local computers as normal, but see only 

a virtual desktop as a full-screen, seamless window. In this mode, the user experience 
is indistinguishable from that of a local desktop. In contrast to the window view mode, 
there is no virtual desktop window to control. 
This configuration offers less control to users and is suited to office-based task workers 
performing repetitive tasks in standardized environments. These users need access 
only to a single virtual desktop. 

 
This section guides you through the setting up of both modes, and includes the following tasks: 

 

• Task 1. Preparing the Endpoint Device 

• Task 2. Convert the Endpoint Device to Full-Screen-Only Mode 

• Task 3. Connect to a Virtual Desktop from a Thin Client Device 

• Task 4. Observing Virtual Desktop Usage 

Task 1. Preparing the Endpoint Device 

This task describes how to configure an endpoint device so users can access virtual desktops in 
firstly in window-view mode from within a local desktop session. 

This task includes the following procedures: 

• Configure the endpoint to receive virtual desktops 

• Experience a virtual desktop in a window-view mode 

To configure the endpoint to receive virtual desktops 
This procedure applies only to Windows XP endpoint devices. 
 

1. Check that the endpoint is a member of the domain XenDT.net. If it is not, add the 

endpoint to domain. 
2. Log in to the endpoint device and insert the XenDesktop Components disk. 
3. Locate and run DesktopReceiverEmbedded-1.msi 

 
Note: Some text in the Citrix Desktop Receiver Embedded Edition user interface, 

including the Help, refers to the “Citrix Presentation Server Clients for Windows” and to 
“Citrix Presentation Server Client (XenDesktop)”. 
 

4. On the Select Language dialog box, select your language from the drop-down list and 
click OK. 

5. On the Welcome page, click Next. 
6. Read and accept the license agreement, and click Next. 
7. On the Select Client page, accept the defaults and click Next. 
8. On the Server Address page, type the value of the IP address (192.168.1.11) of the 

Desktop Delivery Controller VM (vDesktopDDC) on pServerOne, and click Next. 
9. On the Select Program Folder page, accept the defaults and click Next. 
10. On the Client Name page, accept the defaults and click Next. 
11. On the Use Local Name and Password page, select Yes and click Next. 



 

12. On the 
selected and 
computer.  C

13. On the 
14. Click 

A shortcut to 

To experience a virtual desktop in window
1. On the endpoint’s desktop, double

Program Neighborhood Agent 

using the credentials you created in “To 
The 

area
2. Click this icon to open the popup menu and navigate to the 

view the virtual desktop(s) that are available for connection.
3. Click a virtual desktop to open it. The virtual desktop appears in window

with a toolbar for full user control of the window, as shown below.

Task 2. Converting the Endpoin

Mode 
This task describes how to configure an endpoint device so users experience a seamless virtual 
desktop in full
 
This task includes the following steps:

• Enable the full

• Experience a seamless virtual desktop

To enable the full

Full-screen-only desktops require a second installation (in addition to the Desktop Receiver 
Embedded Edition installation) as follows:

1. On the same endpoint device that you configured in Task 1, run 
DesktopReceiverEmbedded

the XenDesktop Components 
2. On the 

agreement, and click 
3. Wait until the 
4. Click 
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On the Program Neighborhood Options page, verify that all check
selected and change the setting to Yes to enable access to virtual desktops on this 
computer.  Click Next. 
On the Ready to Install page, review the summary and click 
Click Finish.  

shortcut to Citrix Program Neighborhood Agent appears on the desktop.

To experience a virtual desktop in window-view mode 
On the endpoint’s desktop, double-click the newly installed shortcut to open the 
Program Neighborhood Agent logon-dialog box.  Type you name and password 

using the credentials you created in “To create user accounts” on page 
The Citrix Program Neighborhood Agent icon appears in the Windows notification 

area 
Click this icon to open the popup menu and navigate to the Desktops 

view the virtual desktop(s) that are available for connection. 
Click a virtual desktop to open it. The virtual desktop appears in window
with a toolbar for full user control of the window, as shown below.

Task 2. Converting the Endpoint Device to Full

This task describes how to configure an endpoint device so users experience a seamless virtual 
desktop in full-screen-only mode.  

This task includes the following steps: 

Enable the full-screen-only mode on the endpoint device  

Experience a seamless virtual desktop 

To enable the full-screen-only mode on the endpoint device

only desktops require a second installation (in addition to the Desktop Receiver 
Edition installation) as follows: 

On the same endpoint device that you configured in Task 1, run 
DesktopReceiverEmbedded-2_en.msi, which installs the full

the XenDesktop Components installation media. 
On the License Agreement page, read and accept the terms of the license 
agreement, and click Install. 
Wait until the Installation Completed dialog box appears, and then click 
Click Yes to restart the computer and complete installation 
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page, verify that all check boxes are 
to enable access to virtual desktops on this 

page, review the summary and click Next. 

appears on the desktop. 

click the newly installed shortcut to open the Citrix 
Type you name and password 

create user accounts” on page 18. 
icon appears in the Windows notification 

Desktops submenu to 

Click a virtual desktop to open it. The virtual desktop appears in window-view mode 
with a toolbar for full user control of the window, as shown below. 

 

t Device to Full-Screen-Only 

This task describes how to configure an endpoint device so users experience a seamless virtual 

only mode on the endpoint device 

only desktops require a second installation (in addition to the Desktop Receiver 

On the same endpoint device that you configured in Task 1, run 
, which installs the full-screen-only client, from 

read and accept the terms of the license 

dialog box appears, and then click Close. 
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To experience a seamless virtual desktop 

When the computer restarts, a Windows start-up dialog box appears, followed by the standard 
Log On to Windows dialog box. 

1. Log into the computer as one of the authorized users that you created in “To create 
user accounts” on page 18. 
 
Note: To experience the virtual desktop in full-screen-only mode, you must log on as a 
domain user, not as an administrator. If you log on as a local or domain administrator, 

you log on to the local computer. 
 

Citrix startup messages appear while the connection to the virtual desktop is being 
established. 

2. You are now connected and able to use the virtual desktop.  When users work in this 
environment, they are unaware that the desktop is being hosted remotely. 

3. Log off.  The standard Welcome to Windows dialog box appears. 

Task 3. Connecting to a Virtual Desktop from a Thin Client 

Device 

Connection from a thin client depends on the type of thin client and whether the client supports 
a Web browser or, alternatively, the Citrix XenApp plugin.  

To connect to a virtual desktop from a thin client device 

There are two main options: 

• Option 1: Thin client supports a Web browser 

 
Specify the following start-up URL for the thin-client Web browser: 
http://vDesktopDDC. 

• Option 2: Thin client supports Citrix XenApp plugin 

 
Specify the following start-up URL for the PNAgent 
http://vDesktopDDC/Citrix/PNAgent/config.xml. 

In this deployment, vDesktopDDC is the name of the server VM on which Desktop Delivery 

Controller runs. 
 
Note: These options are not explicitly supported in this release because of differences in the 

thin client manufacturer’s configuration tools.  Check the documentation of your thin client for 
details on how to setup these options. 
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Task 4. Observing Virtual Desktop Usage  

As an administrator, you can use the administration consoles to observe the changes that take 
place in the evaluation environment both before and after a user logs on. 

 

Access Management Console The connection state of the virtual desktop changes In 
Use. 

Right-click the desktop in use, and click 
Shutdown/Suspend. 

Note that you can administer the VMs directory from the 
Access Management Console without having to go to the 
hypervisor’s console. 

SCVMM Admin Console 

or Hyper-V Manager 

Additional VMs has been started to maintain a larger pool 
count of three, as specified in Task10. 

Provisioning Server Console Right-click vDisk1, and click Show Connections. 

Note that all the computers that are currently running are 
using the same vDisk. 

 


